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2015 Knowledge-Based Audits™ of Single Audit Entities for ProSytem fx® Knowledge Coach
Welcome to 2015 Knowledge-Based AuditsTM of Single Audit Entities for ProSystem fx® Knowledge Coach
This Release Notes document provides important information about the 2015 release of Knowledge Based Audits TM of Single Audit
Entities. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998, option 4,
then option 1. Additional information is available on CCH Support Online.

New in this Release
Knowledge-Based Single Audits is a supplement to the financial statement audit methodologies provided in Knowledge-Based Audits of
Governmental Entities and Knowledge-Based Audits of Not-for-Profit Entities.
This single audit supplement is designed to help the auditor efficiently and effectively perform the compliance audit portion of the
single audit in accordance with professional auditing standards and the requirements of OMB Circular A-133 that apply to grant awards
received prior to December 26, 2014 or 2 CFR 200 Uniform Administrative Requirements, Cost Principles, and Audit Requirements for
Federal Awards (Uniform Guidance), as applicable.
The frequently asked questions released by the Council on Financial Assistance Reform (COFAR) include information on transition
provisions to the Uniform Guidance. The Uniform Guidance contains administrative requirements and cost principles beginning
December 26, 2014, for all new federal awards and funding increments (additional funding to existing federal awards) with modified
award terms and conditions that are awarded on or after that date. In most cases, the terms and conditions of the federal award should
identify whether the funding increment is subject to the Uniform Guidance requirements, or whether it will continue to be governed by
the original terms and conditions of the federal award (that is, subject to the pre-Uniform Guidance requirements). As a reminder, the
effective date of the Uniform Guidance as it relates to a subaward (pass-through grant to a subrecipient) is the same as the effective
date of the federal award. The audit provisions of the Uniform Guidance apply to audits of fiscal years beginning on or after December
26, 2014. The provisions of the OMB Circulars apply before these dates. 2015 Knowledge-Based Single Audits includes guidance under
both the OMB Circulars and the Uniform Guidance.
The knowledge-based audit is a risk-based methodology that emphasizes using knowledge of the entity to assess and respond to risks
relevant to the audit. Compliance audits are often unique and complex and require specialized accounting and auditing knowledge. This
edition includes specific up-to-date guidance for conducting these compliance audits. Conducting single audits requires the exercise of
the auditor’s professional judgment. This document is published for the purpose of communicating, to users of the toolset, updates and
enhancements included in the current version. This document is not, and should not be used as an audit program to update the audit
documentation of an engagement started in a previous version of this product.
This document is published for the purpose of communicating the updates and enhancements included in the current version to users
of the toolset. This document is not, and should not be used as an audit program to update the audit documentation of an engagement
started in a previous version of this product.
This is the seventh update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.
The 2015 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
The 2015 edition of Knowledge-Based Audits of Single Audit Entities features numerous enhancements, including:

 Updated Knowledge-Based Audit documents (KBAs) titles and text for the 2 CFR 200 Uniform Guidance, the OMB Circulars and
Single Audit guide as applicable.
o

Changed 14 compliance requirements to 12 compliance requirements in KBA-400S by removing the Davis-Bacon Act
and the Real Property Acquisition and Relocation Assistance columns.

o

o

Added section for control activities and modified the conclusion to include assessment of how components are
operating together in KBA 401N and KBA401S. All Relevant Principles and Points of Focus were updated for the
Internal Control: Integrated Framework (COSO Framework) published by the Committee on Sponsoring
Organizations of the Treadway Commission, as incorporated by reference in Part 6 of the OMB Compliance
Supplement.
Modified the Type of Compliance Requirement/Specific Risk column in the table by deleting “Davis-Bacon Act” and
“Real Property Acquisition and Relocation Assistance” (now “reserved” as placeholder and N/A) and changed “Period
of Availability of Federal Funds” to “Period of Performance of Federal Funds” in KBA 502S.

 Updated Audit Programs (AUDs) for the 2 CFR 200 Uniform Guidance and the OMB Circulars including:
o
o

Removed Davis-Bacon Act and Real Property Acquisition and Relocation Assistance requirements in AUD 701.
New tables for risk assessment / applicability in AUD-802S, AUD-803S, AUD-804S.

o

Separate sets of steps for OMB Circulars and 2 CFR 200 in AUD-802S, AUD-803S, AUD-804S, AUD-805S, AUD808S, AUD-810S, AUD-811S, AUD-814S, AUD-815S and AUD-817S.

o

Two compliance requirements removed from AUD-806S and AUD-813S since there are no longer compliance
requirements under the 2015 Compliance Supplement.

 Practice-Aids (AIDs) and Resource-Documents (RESs) updated throughout in accordance with the provisions of 2 CFR 200
Uniform Guidance.

 Correspondence-Documents (CORs), and Auditor’s Reports (RPTs) updated throughout in accordance with the provisions of 2
CFR 200 Uniform Guidance. Several of these documents and reports have 2 versions: one version references the OMB Circulars
and a separate version references the Uniform Guidance.
Note: The audit provisions of the Uniform Guidance apply to audits of fiscal years beginning on or after December 26, 2014. The
provisions of the OMB Circulars apply before these dates. 2015 Knowledge-Based Single Audits includes guidance under both the OMB
Circulars and the Uniform Guidance.
For more information on specific program enhancements, review the 2015 Single Audit Entities Overview for Knowledge Coach Users
available at the following link or in the binder through the KCO-001 workpaper.
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20Single%20Audit%20Title%20Overview%20for%20Knowl
edge%20Coach%20Users.pdf
In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:
New literature, standards, and developments, reflected in the following current audit and accounting guidance:








AICPA Statement on Quality Control Standards No. 8, A Firm’s System of Quality Control (Redrafted).
SAS-129, Letters for Underwriters and Certain Other Requesting Parties.
Government Auditing Standards, December 2011 Revision (Yellow Book).
Committee of Sponsoring Organizations – 2013 update to Internal Control—Integrated Framework.
AICPA Code of Professional Conduct—Revised.
Securities and Exchange Commission—Municipalities Continuing Disclosure Cooperation Initiative 2014 (Rule 15c2-12 of the
Securities Exchange Act of 1934).

 Title 2 U.S. Code of Federal Regulations (CFR) Part 200, Uniform Administrative Requirements, Cost Principles, and Audit
Requirements for Federal Awards (Uniform Guidance).

 Joint Interim and Final Rule (JIFR), as of December 2014.
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Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

 An Overview that guides auditors through the methodology (for single audits, auditors can refer to the applicable Overview in
Knowledge-Based Audits of Governmental Entities or Knowledge-Based Audits of Not-for-Profit Entities);

 Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS, GAGAS, the OMB Compliance Supplement and the Uniform Guidance;

 Customizable Audit Programs that take auditors through related steps and procedures of the compliance audit;
 Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

 Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements and the accompanying
internal control and compliance reports required by GAGAS, the OMB Compliance Supplement and the Uniform Guidance; and

 Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.

 The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards and AU-C Section 935, Compliance Audits, as applied
to the conduct of a single audit pursuant to the requirements of OMB Circular A-133 and the Uniform Guidance, are supported
with practice aids and tools to make the most of the latest technology to address audit requirements and the processes auditors
will need to implement in auditing compliance over federal awards pursuant to OMB Circular A-133 and the Uniform Guidance.
The knowledge-based audit (KBA) methodology will assist auditors of single audits by:


Facilitating compliance with GAAS and GAGAS, the OMB Compliance Supplement and the Uniform Guidance;



Encouraging more effective audits through tailored audit programs and comprehensive practice aids;



Helping auditors to focus on and respond to identified audit risks of noncompliance; and



Enhancing audit documentation.

ProSystem fx® Knowledge Coach

 ProSystem fx® Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently
by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each particular
engagement, and documenting the link between risks identified and procedures performed. AUD-100S Tailoring Question
Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the
engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and unnecessary
workpapers.

 Before you begin your audit, please review the guidance in AUD-101S Overall Audit Program: Compliance Audit of Federal
Awards. This workpaper is intended to be your road map through a Knowledge-Based Audit methodology. You should start your
audit with AUD-100S Tailoring Question Workpaper and AUD-101S Overall Audit Program: Compliance Audit of Federal
Awards.

 Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502S
Summary of Risks of Noncompliance. This allows the user to continuously assess risks during the engagement. Several
workpapers prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to document those
risks. All documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper
identified in” field of the Risk pane.

 Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

 Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.
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 Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB and GASB Accounting Standards Codifications and the auditing standards issued by
the AICPA and the U.S. Government Accountability Office (GAO). Also, if you subscribe to the Knowledge-Based Audits of
Single Audit Entities Guide on ARM, you can take advantage of links to the audit guide material from within the Knowledge
Coach documents.

 Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.
Important Notes

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
 If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o
o

Keep the binder with the affected workpapers open.
Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.
System Requirements

 This title MUST be used with CCH® ProSystem fx ® Engagement version 7.2, ProSystem fx® Knowledge Coach version 2.2, and
2015 Compliance Base and higher. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please contact Technical
Support at 1-800-PFX-9998, option 4 for detailed instructions.

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions
Download the 2015 Knowledge Based Audits of Single Audit Entities from the ProSystem fx ®Knowledge Coach Updates section of the
ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select the
Knowledge Coach Series and Download file link next to the 2015 Knowledge-Based Audits of Single Audit Entities. On some occasions
the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.
You must install the 2015 Compliance Base title before installing the 2015 Knowledge Based Audits of Single Audit Entities.
The 2015 Compliance Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach
Important: CCH® ProSystem fx® Engagement version 7.2 or higher and Knowledge Coach version 2.2 and CCH® ProSystem fx®
Engagement version 7.2 and Knowledge Coach 2.2 September 2015 Update must be installed on the computer in order to install this
Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary Interop Assemblies
(PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System Runtime version
3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office Runtime 4.0 (VSTOR)
(32-bit version for 32-bit OS and 64-bit version for 64-bit OS).
The 2015 Knowledge-Based Single Audit Entities (11/18/15). KCP download is a proprietary file that must be installed from within
Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in the Release Bulletin.

Installation Instructions
Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.
After downloading the 2015 Knowledge Based Audits of Single Audit Entities, do the following:
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 Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

 The Knowledge Coach Titles window will be displayed.
 Choose Add Title.
 Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

 Choose Open.
 The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.
Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.
To unrelease a title:

 Select a version of the KBA Single Audit Entities titles.
 Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.
Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.
To release a title:

 Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
 Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.
Important: Once the 2015 Knowledge-Based Audits of Single Audit Entities titles have been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key
Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.2 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2015
Knowledge-Based Audits of Single Audit Entities.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager
CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.
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Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.
Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.
Also available in the Knowledge-Based Audits of Single Audit Entities title, a guide that helps you comply with the most recent
professional standards and guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools, and
other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are available
in Knowledge Coach.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.
Reference to Accounting Research Manager (ARM) – If you subscribe to an ARM library that includes single audit content, you can link
directly to source material from Resources within Knowledge Coach documents. These links have been updated to refer to the
accounting standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Audits of
Single Audit Entities Guide on ARM, you can take advantage of references to the guide material from within the Knowledge Coach
documents.
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Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper
Templates, open a binder in ProSystem fx®
Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select
New Knowledge Coach Workpaper from the toolbar
or File menu. The New Knowledge Coach
Workpaper dialog appears (Figure 1).
Select the New Knowledge Coach Title with the
content you would like to use. You can only select
titles you have installed. The information displayed
changes to reflect the workpaper organization
available for the selected title. Select the Knowledge
Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper
Properties dialog appears. Each workpaper name is
automatically loaded into the Name field. Add a
workpaper index in the Index field and make any
Name modifications you desire. You can also modify
the tab location or the roll forward settings for each
workpaper. Then click OK. The integrated
Knowledge Coach workpaper is now inserted into
your engagement binder. For more information on
how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.

Figure 1 - New Knowledge Coach Workpaper
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Download
Description:

2015 Knowledge-Based Audits of Single Audit Entities
Title(11/18/2015)

Version:

Engagement v. 7.2 with Knowledge Coach 2.2 or higher and
2015 Compliance Base and CCH® ProSystem fx® Engagement
7.2 and Knowledge Coach 2.2 September 2015 Update

Release Date:

November 2015

File size:

18MB

Approx.
Download
Time:

42 minutes at 56 kbps

License:

Full Version

Platforms:

Windows® 7, 8 and 8.1

Office:

Microsoft® Office 2007 required

Contact Information

 For a demo or to purchase additional titles as they become available

1-800-PFX-9998, option 1

 Technical Support

1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.
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